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INTRODUCTION
Welcome to Quick Part Series - Chocolate Mold tutorial. In this course you will explore how to design
andmachine a heart-shaped candy mold. Starting with a solid heart provided with this tutorial, you will
use wireframe and solid CAD tools to modify the heart to create a candy mold. Using a variety of rough
and finish toolpaths, you will programand verify the model to ensure it can be cut successfully. Finally,
you will post out your toolpaths to generate NC code and cut the candy mold.

This tutorial will provide you with the basic techniques needed to create the mold, and then from there
you can explore Mastercamand challenge yourself to make some other interesting products.

Tutorial Goals
l Understand basic wireframe and solidmodel design tools and how they can be used to create a
complex solidmodel

l Learn how to programapart using rough and finish toolpaths

l Gain knowledge on how to safely fixture the part

l Explore how to verify the toolpaths withMastercam Simulator

l Machine the final candy mold

NOTE
Screen colors in the tutorial pictures were modified to enhance image quality; they may not
match your Mastercam settings or the tutorial results. These color differences do not
affect the tutorial or your results.

General Tutorial Requirements
All MastercamProject Based Learning tutorials have the following general requirements:

l Youmust be comfortable using the Windows® operating system.

l Each exercise in the tutorial builds on the mastery of the preceding exercise's skills. We
recommend that you complete them in order.

l Additional filesmay accompany a tutorial. Unless the tutorial provides specific instructions on
where to place these files, store them in a folder that can be accessed from the Mastercam
2020 workstation, either with the tutorial or in any location that you prefer.

l All Mastercam tutorials require you to configure Mastercam to work in a default Metric or Inch
configuration. The tutorial provides instructions for loading the appropriate configuration file.

Starting Mastercam Quick Part
NOTE
The Quick Part Series tutorials assume you are using an Educational license and the
MastercamQuick Part interface. If you are using an Industrial license, disregard this
section.
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The Quick Part interface is a simplified version of the Mastercam interface, hiding some of the more
complex functions. Upon startingMastercam, the following prompt displays:

Select Quick Part.To return to the standardMastercam interface, you need to close and re-open
Mastercam. Then select Standard.

Mastercam Part Files
The provided part files are in .mcam format. This allows both Industrial and Educational license users to
open the part files. Files saved with an Educational license have an .emcam file extension. This does not
affect the completion of the tutorial.

Material Requirements
The followingmaterials are recommended to complete the candy mold project using the suggested
machine definition, feeds and speeds, and tooling used in this tutorial. Using different materials will
affect the tooling and toolpath settings.

When calculatingmaterial requirements, consider a finalmold size of 100 mmx 100 mmx 25.4 mmper
student.

l Food Contact Grade Plastic UHMWMaterial, Polyethylene White, 1-inch thick cut into 100 mmx
100 mmx 25.4 mmpieces

l Wilton Cookie Sticks, 0.2 inch diameter x 6 inch long (5 mmdiameter x 152 mm long)

Machine and Tool Requirements
WARNING
This tutorial is completed using a specificmachine andmaterial. The settings, tooling, feeds,
and speeds recommended in this tutorial are based on the use of this equipment, as well as
the material to be machined. Your resultsmay differ, based on the machine, its age and
prior utilization, and tooling used, as well as the material selected for machining.

This tutorial recommends the following:
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l A minimum standardmill, capable of machining hard plastic, with awork envelope of at least 100
mmx 100 mm (4 inch x 4 inch), and amachining envelope that includes Z height of 100 mm (3.93
inch).

l A Machinist's Vise

l 6.0 mmFlat EndMill

l 3.0 mmBall EndMill

Accessing the Home Learning Edition
The MastercamHome Learning Edition (HLE) is a free version of Mastercam that lets you practice
design and programming skills without having a full Mastercam license. The HLE software lets you save
your Mastercam files, but it will not post code.

The HLE is available for free at the following location: https://signup.mastercam.com/demo-hle.

Quick Part Series - Chocolate Mold—4: Introduction
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CHAPTER 1
HEART MOLD DESIGN

In this chapter you will use the design functions of Mastercam to create a heart shaped candy mold.
You will start with a solid part that you will use to produce a heart-shaped impression into a block that
you create usingMastercamdesign (CAD) tools.

Goals

l Understand levels

l Use wireframe and solid CAD tools to create geometry

l Create block for the mold

Exercise 1: Configuring Mastercam
In this exercise, you openMastercamand set your system configuration to be metric.

1. Start Mastercamusing your preferredmethod:

a. Double-click Mastercam's desktop icon.

OR

b. LaunchMastercam from the Windows Start menu.

2. Select the default metric configuration file:

a. Click the File tab.

b. Choose Configuration fromMastercam's Backstage View to open the System
Configuration dialog box.

c. Choose ...\mcamxm.config <Metric> from the Current drop-down list.

d. ClickOK.
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Exercise 2: Opening the File and Exploring Levels
In this exercise, you will open the Heart mm.mcam file provided with this tutorial and explore the
LevelsManager.

1. Click File, Open and open the Heart mm.mcam file provided with this tutorial.

2. Save the part as Heart mm-XXX.mcam, where XXX represents your initials so that you do not
overwrite the original file.

3. Right-click the heart and select Top (WCS).

4. Right-click again and select Fit to bring the solid to the center of the screen.

10
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5. Click Levels to open the LevelsManager. You will see that there are two levels, Level 1 which
contains the heart and Level 101 which contains a sample machinist's vice.

NOTE
Level 1 one is the active level as indicated by the green check in the Number column.
The active level is always visible as indicated by the X in the Visible column.

6. Click in the Visible column for Level 101 to make the vise show in the graphics window, and then
click in the Number column for Level 101 to make it the active level.
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7. Turn off the visibility for Level 1 by clicking in the Visible column to remove the X. Only the vise
should appear in the graphics window.

8. Before beginning the next exercise, return the active level to Level 1 and hide the vise by
clicking in Visible column for Level 101. This will ensure you do not accidentally select the vise
when creating your mold geometry.

9. Save the file.

Exercise 3: Modifying the Solid Model
In this exercise, youmodify the solidmodel to eliminate an interior, sharp edge where the heart joins
the curves. Softening the sharp edge of the heart will ease the transition between surfaces for a better
finish and will make it easier to remove the candy from the mold.

1. Your file Heart mm-XXX.mcam which you saved from the previous exercise should be open in
Mastercam.
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2. Activate the Translucency toggle and set the 2D/3D toggle on the Status bar to 2D. Setting
your constructionmode to 2D will place any geometry you create parallel to the current
construction plane (Top (WCS) at the current systemZ depth.

3. Hold down the middle mouse button and rotate the heart until you can see the internal, sharp
edge as shown in the following image.

You will use Mastercam's CAD functions to soften this edge.
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4. Right-click in the graphics window and select GView, Back (WCS).

The model rotates to show the back view.

5. On the Solids tab, click Face to Face Fillet.

14
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The Solid Selection dialog box displays andMastercamprompts you to select one or more
entities

6. Select the three faces on the left side of the model and clickOK in the Solid Selection dialog
box.
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7. Select the three faces on the right side of the model and clickOK.

The Face to Face Fillet function panel displays.

8. Choose the Radius as theMethod and enter 1.0 in the Radius field. A preview of the results
shows in the graphics window.
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9. ClickOK (green checkmark). Rotate the solid to see the results.

NOTE
Use the Translucency and Shaded toggles on the Status Bar to change your view.

10. Save your file.

Exercise 4: Creating Geometry for the Mold
In this exercise, you will find the center point of the solid heart using the Bounding Box function, and
create the wireframe geometry that will become the mold.

1. Your file Heart mm-XXX.mcam which you saved from the previous exercise should be open in
Mastercam.

2. Ensure that the 2D/3D toggle on the Status Bar is set to 2D. Setting your constructionmode to
2D will place any geometry you create parallel to the current construction plane (Top (WCS) at
the current systemZ depth.

3. Click Translucency on the Status Bar to make the solid heart translucent.
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4. On theWireframe tab, select Bounding Box to open the function panel.

5. Select the heart in the graphics window and click End Selection.
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6. In the Create Geometry section of the Bounding Box function panel, select Center Point. This
will locate the exact center point of the solid heart.
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7. ClickOK in the Bounding Box function panel to accept. You will use the bounding box center
point in the next step.

8. From theWireframe tab, click Rectangle to open the Rectangle function panel.

9. Select Anchor to center. This will center the rectangle you create around the solid heart.
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10. On the Selection Bar, choose AutoCursor, Point.

11. Click on the point at the center of the solid heart. This will anchor the rectangle to that point.
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12. Enter 100.0 in theWidth andHeight fields.

13. ClickOK to create the rectangle that will become the block for the mold

14. Save your file.
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Exercise 5: Creating the Block for the Mold
In this exercise you will create a block for the candy mold by extruding the rectangle you created in the
previous exercise.

1. Your file Heart mm-XXX.mcam which you saved from the previous exercise should be open in
Mastercam.

2. Right-click in the graphics window and select the Isometric (WCS) view.

3. Click Extrude on the Solids tab to open theWireframe Chaining dialog box.
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4. Ensure that the Selection Method is set to Chains and then select the rectangle.

5. ClickOK inWireframe Chaining dialog box and the Solid Extrude function panel opens. The
solidmay be extruded in a positive direction as shown in the following image.
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6. Click Reverse in the Solid Extrude function panel to change the direction to a negative direction.
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7. Hover over the arrowuntil the ruler displays and then click and drag until the distance is
25.0mm.

NOTE
You can type 25.0mm in on-screen field and press [Enter] to accept the value.
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8. Alternately you can enter 25.0 in the Distance field of the Solid Extrude function panel.

9. Verify that the Type is set to Create body.
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10. ClickOK to create the block.

11. Save your file.

Exercise 6: Using Boolean to Create the Mold Impression
In this exercise you will use the Boolean function to transform the solid heart into the impression that
will be your candy mold. When using Boolean, you will identify the target body, which is the block and
the tool body, which is the solid heart.

1. Click Boolean on the Solids tab. Mastercamprompts you to select the target body.
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2. Select the top surface of the block to be the target body.

The Boolean function panel opens andMastercamprompts you to select the tool bodies

3. In the Boolean function panel, select Remove and then click Add Selection. By choosing
Remove, the solid heart will be taken away from the block leaving an impression that will become
the candy mold.
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4. Ensure that the Body selection filter is chosen in the Solid Selection dialog box, and then select
the solid heart

5. ClickOK in the Boolean function panel and the heart is removed from the block.

6. Click the Select all Entities by ColorQuick Mask.

30
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Quick Masks help you to quickly select entities in the graphics window. Many Quick Masks have
two functions, Select all entities or Select only entities, (depending onwhether you click the right
or left side of the button).

7. In the Select All dialog box, ensure that All entities is chosen and then select the check box for
the lavender color
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8. ClickOK and the wireframe heart geometry is selected in the graphics window.

9. Press [Delete] on your keyboard.

10. Click the Select all point entities Quick Mask.

This selects the point that was created from the Bounding Box.
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11. Press [Delete] on your keyboard to remove the point.

12. Save your file.

Exercise 7: Adding a Containment Boundary
A containment boundary is used to limit the areas of the part that can be machined. In this exercise,
you will add awirefame containment boundary to the heart shape. When programming the toolpaths
you will set the containment boundary strategy to the Stay Inside. This allows the tool to machine the
area inside the geometry and not pass through the boundary.

1. Your file, Heart mm-XXX.mcam, which you saved from the previous exercise should be open
inMastercam.

2. Click the Levels tab to bring the LevelsManager to the forefront.

3. Click Add a new level, (green plus sign icon).

4. Click Add a new level, (green plus sign icon). In the LevelsManager enterWireframe in the
Name field of the new level.

Notice that level 2 is the active level. The newgeometry you will create in this exercise will reside
on this level. Ensure that the Vise level (101) is not visible. The Visible column should be empty. If
there is an X in the column click it to remove the X and hide the level in the graphics window.
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5. On theWireframe tab, click Curve One Edge.

6. Press the [Shift] key and select the edge of the heart. Thismethod selects all tangent edges.
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7. ClickOK in the Curve On One Edge function panel.

The newwireframe entities appear on level 2 in the LevelsManager.

8. Save your file.

Exercise 8: Adding a Chamfer to the Mold
In this exercise, you will use one of Mastercam's chamfer functions to add a bevel to the edge of the
heart impression. Adding a chamfer to the mold edge will make it easier to remove the candy from the
mold.

1. Your file, Heart mm-XXX.mcam, which you saved from the previous exercise should be open
inMastercam.

2. In the LevelsManager, click level 1, Heart to make it the active level (designated by a green
check), and clear the visibility for level 2,Wireframe.
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3. On the Solids tab, clickOne Distance Chamfer.

The Solid Selection dialog box displays andMastercamprompts you to select the entities to
chamfer.

4. Click Edges to set the selection filter to only select edges. Deselect Face, Body, or From back if
they are selected.
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5. Select one segment of the heart's edge and clickOK in the Solid Selection dialog box.

6. In the One Distance Chamfer function panel, select Propagate along tangencies to chamfer
all edges that are tangent to the one you selected.

NOTE
You can also hold down the [Shift] key when selecting the edge to chamfer and all
tangent edgeswill be selected automatically.
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7. Enter a value of 0.75 in the Distance field and then clickOK.

The heart has chamfers on all edges. Hold down the middle mouse button and rotate your part
to see the all of chamfered edges.

8. Save your file.
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Exercise 9: Adding Stick Slot Geometry
In this exercise, you will create the geometry required to machine a slot in the mold to hold a candy
stick. The slot will be angled at five degrees to ensure that the stick is firmly embedded in the candy and
seals the opening to prevent leakage of the liquid chocolate.

1. Your file, Heart mm-XXX.mcam, which you saved from the previous exercise should be open
inMastercam.

2. On the View tab, click Show Axes and Show Gnomons to activate them. Use the function's drop
downs to choose which axes and gnomons display in the graphics window.

3. Set the 2D/3D toggle on the Status Bar to 3D.

4. Right-click in the graphics window and set your view to Isometric (WCS).

5. Right-click and choose Fit to center your part in the graphics window.

6. On the Transform tab, clickMove to Origin.

7. Click the lower left corner of the mold as shown in the following image.
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The moldmoves to the origin.

The mold color is nowpurple which is the results color for a transformation.

8. Click Clear Colors on the View tab to return all entities their default colors.

9. Select Show Axes and Show Gnomons to hide them in the graphics window.

10. Set that the 2D/3D toggle on the Status Bar is set to 2D. Setting your constructionmode to 2D
will place any geometry you create parallel to the current construction plane (Top (WCS) at the
current systemZ depth.
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11. In the PlanesManager, click in the C column to set your construction plane (Cplane) to Front. The
construction plane is the plane onwhich you will create the geometry.

12. In the LevelsManager, click Add a new level.

13. Enter Slot geometry in the Name field of the new level.

14. Right-click in the graphics window and set your view to Front (WCS). Choose Fit to center your
part in the graphics window.

15. On theWireframe tab, click Circle Center Point.
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16. Select AutoCursor,Midpoint to set a snap to position.

17. In the Circle Center Point function panel, enter 5.5 in the Diameter field and then click the
Lock icon to maintain that diameter.

18. Hover over the top edge of the mold until the center point displays and click to set the location of
the circle.
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19. In the Circle Center Point function panel, unlock the diameter and then clickOK.

NOTE
The function panel will maintain settings from session to session, unlocking the
diameter before closing is a good practice.

20. On theWireframe tab, click Line Endpoints.

21. Click the center point of the circle and drag up approximately 5 mm. Click to set the second
endpoint.

22. In Line Endpoint function panel, enter a Length of 5.23 and an Angle of 90.

23. ClickOK to accept the values.
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24. On theWireframe tab, clickOffset Entity.

25. Select the line you just drew and then click to the left in the graphics window to indicate the
direction to offset.

26. On the Offset Entity function panel, chooseMove and Both sides for the Direction.
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27. In the Distance field, right-click and select R = Radius of an arc.

28. Select the arc. The linesmove to be tangent to the arc.

29. ClickOK in the Offset Entity function panel.

30. On theWireframe tab, click Line Endpoints. Ensure that theMethod is Two endpoints.
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31. Draw a line between the two endpoints of the lines and clickOK.

32. Right-click in the graphics window and click Clear Colors to return the purple results color to the
default color.

33. On theWireframe tab, clickDivide.

34. In the Divide function panel, choose Trim.

35. Click the top of the arc to remove that section.
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36. ClickOK in the Divide function panel. The geometry should look like the following image.

37. On the Transform tab, click Translate. You will be using the Translate function to move the
geometry into the proper position.

38. Select the geometry you created and then click End Selection.

Quick Part Series - Chocolate Mold—1: Heart Mold Design



39. In the Translate function panel selectMove as theMethod and enter -3.64 in the Y axis field.
Entering a negative value places the circle below the Y axis.

40. ClickOK to accept the values.

41. On the Transform tab, click Translate.
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42. Click the Quick Mask, Select all results entities to quickly select the geometry you just
moved.

43. In the Translate function panel, enter 1.76 in the Z field to move the geometry forward.
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44. ClickOK. Rotate your part to view the geometry.

45. In the PlanesManager, set the construction plane to Right.

46. On the Transform tab, click Rotate.

47. Select the geometry by clicking the entities or use the Quick Mask, Select all results entities,
and then click End Selection.
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48. In the Rotate function panel, click Rotation Center Point Reselect.

49. In the graphics window, click the center point of the original arc which appears as a green
AutoCursor point, (not the blue and white rotation point).

50. Hover over the Dynamic Gnomon until it highlights and then click and rotate it to -5.00 degrees,
or enter the value in the on-screen field and press [Enter].
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NOTE
Alternately, you can also enter -5.00 in the Angle field of the Rotate function panel.

51. ChooseMove in the Rotate function panel and clickOK.
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52. Right-click and choose Right (WCS) to verify the results.

53. Return the view to Isometric (WCS).

54. On the Solids tab, click Extrude.

TheWireframe Chaining dialog box displays.

55. Select the geometry and then clickOK.
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56. In the Solid Extrude function panel, choose Cut Body as the Type, and enter aDistance of
25.0.

57. ClickOK.

58. Return to the LevelsManager and notice that the four entities you just created on level 3, Slot
geometry. Experiment with the visibility to see what shows in the graphics window.

59. Save your file.
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SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. You can use an STL file in a Solids Boolean remove operation.

a. True

b. False

2. The 2D constructionmode places geometry parallel to the current construction plane.

a. True

b. False

3. Which Solid Boolean option combines two solids into one solid?

a. Add

b. Remove

c. Common

4. Which Solid Boolean option leaves an impression of one solid in another solid?

a. Add

b. Remove

c. Common

5. Which of the following doesnot set the size of the fillet in the Face to Face Fillet function?

a. Diameter

b. Radius

c. Width

6. Which function on the Transform tab changes the angle of an entity or a group of entities.

a. Dynamic

b. Translate

c. Rotate

d. Project

7. List some characteristics in amodel that can hurt the chances of a casting being successfully
released from the mold.
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CHAPTER 2
FIXTURING THE STOCK

Selection of the proper fixture is important to successfulmachining. The choice of fixture involves
consideration of the size of the piece to be machined, and the ability to machine around the exterior
and the interior of the piece successfully, while avoiding the fixture itself.

For this tutorial, the fixture selected is a standardmachinist's vise. The vise is elevated on parallels to
allowmachining of the exterior and interior of the part.

Goals

l Explore the machinist vice provided with this tutorial

l Understand fixturing options

l Experiment withmoving your part to the machine origin

Exercise 1: Moving the Mold to the Origin
In this exercise, you will move the candy mold to the origin for the providedmachinist vice on the
default the mill machine.

WARNING
This project is completed using a specificmachine andmachinist vise model provided with
this tutorial. The setup and fixturing of your machine may vary.

1. Your file, Heart mm-XXX.mcam, which you saved from the previous chapter should be open
inMastercam.

2. On the View tab, click Show Axes and Show Gnomons to activate them. Use the function's
drop downs to choose which axes and gnomons display in the graphics window.

3. Set the 2D/3D toggle on the Status bar to 3D.

4. Right-click in the graphics window and set your view to Isometric (WCS).

5. Choose Fit to center your part in the graphics window.
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6. In LevelsManager, make the Heart,Wireframe, and Slot geometry levels visible andmake level
1 the active level.

7. On the Transform tab, clickMove to Origin.

8. Click the upper left corner of the mold as shown in the following image.
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9. The moldmoves to the origin.

10. The mold color is nowpurple which is the results color for a transformation. Click Clear Colors on
the View tab to return all entities their default colors.

11. You can click Show Axes and Show Gnomons to hide them in the graphics window.

Exercise 2: Choosing a Machine and Setting Up Stock
In this exercise, you will choose amachine and setup your stock.

1. Your file, Heart mm-XXX.mcam, which you saved from the previous exercise should be open
inMastercam.

2. Ensure that the 2D/3D toggle on the Status bar is set to 3D.

3. Click the Planes tab to bring the PlanesManager to the forefront.
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4. Click in theWCS column for the Top plane and then click the Set your current WCS,
construction plane, and tool plane with their origins to the selected plane.

5. On theMachine tab, choose the Defaultmill machine from the drop-down.

6. Click the Toolpaths tab to bring the Toolpaths Manager to the forefront. Note thatMachine
Group 1 is theMill Default MM.

7. Expand the Properties group.
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8. Click Stock setup to open the Stock Setup page of theMachine Group Properties dialog box.
Confirm that the Stock Plane is set to Top.

NOTE
If the Stock Plane is incorrect, you can click the icon and choose the correct plane
from the Plane Selection dialog box.
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9. In the illustration, choose the top, back point to set the Stock Origin and then click All Solids.

The values in the Y, X, and Z fields update to the measurements corresponding to the stock you
created (100.0, 100.0, 25.0).

10. ClickOK.

11. Save your file.
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SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. If you do not need to cut the outside edge of a part, a vise can be used to hold the stock.

a. True

b. False

2. You canmachine (cut) on the outside of the stock only if the cut depth does not go deeper than
the amount of stock sticking out above the vise jaws.

a. True

b. False

3. The Move to Origin function...

a. Moves the origin to a specific location on the part

b. Moves the part to the origin

c. None of the above

4. In Stock Setup, the only way to enter the size of the stock is to manually type in the value.

a. True

b. False

5. In Stock Setup, you can display the stock in the graphics window to confirm the orientation and
location of the part.

a. True

b. False

6. What are some benefits of a vise versus hold-down clampswhenmachining a part?

7. What should you consider when you use a vise to hold a part?

8. List some things you can do to ensure that your part will more easily release from your mold?
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CHAPTER 3
ROUGH MOLD PROGRAMMING

A roughing toolpath is typically used to remove large areas of unwantedmaterial to produce a shape
that is similar to the final shape. Using a roughing toolpath followed by a finish toolpath can reduce the
time it takes to machine a part.

Goals

l Programa rough toolpath

l Understand the concepts of machining and avoidance geometry

l Understand and apply a containment boundary to a toolpath

l Explore tool libraries including filtering by tool type

l Experiment with toolpath verification usingMastercam Simulator

Exercise 1: Creating the OptiRough Toolpath
In this exercise, you will programaOptiRough toolpath to rough out the heart mold.

1. Your file, Heart mm-XXX.mcam, which you saved from the previous chapter should be open
inMastercam.

2. Right-click and choose Fit and set your view to Isometric (WCS).

3. In the LevelsManager, make sure the Heart andWireframe levels are visible.

4. On theMill Toolpaths contextual tab, clickOptiRough in the 3D group.

TheModel Geometry page of the Dynamic OptiRough dialog box displays.
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5. Click Select entities in theMachining Geometry section.
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6. Select the heart and slot geometry. You can select each section or use window select as shown in
the following image.
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7. Rotate the part andmake sure that all parts of the mold to be machine are selected.

8. Click End Selection to return to theModel Geometry page.

9. For a rough toolpath you will designate a certain amount of stock to leave on the part. This stock
will be removed with the finish toolpaths. Double-click theWall Stock and Floor Stock fields of
Machining Geometry to activate themand enter 1.0.

10. Click the Toolpath Control page in the tree control.
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11. In this page you will choose the containment boundary to limit the area that will be machined.
Click the Boundary chains select arrow.

TheWireframe Chaining dialog box displays.

12. Hold down the [Shift] key and select a segment of the containment boundary wireframe.
[Shift+click] selects all tangent segments.

13. ClickOK to close theWireframe Chaining dialog box and return to the Toolpath Control page.

14. Select Stay inside for the Strategy to keep the toolpath inside the selectedmachining
geometry.
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15. Select Center to Compensate to. This results in a toolpath in which the center of the tool travels
to the containment boundary.
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16. Click the Tool page in the tree control.

17. Click Select library tool to open the Tool Selection dialog box.

18. Deselect the Filter Active checkbox and then click Filter.

The Tool List Filter dialog box displays.
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19. Clear the filters by clickingNone.

20. Choose the Endmill1 Flat filter and then clickOK.

21. Select the FLAT END MILL - 6 from the library of tools and clickOK.
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22. Enter the following values for the tool.

CAUTION
These valuesmay vary depending on your machine andmaterial.

23. Click the Cut Parameters page in the tree control.
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24. Select the Stepup checkbox and enter the following values for the Passes.

NOTE
The slope of the surface you are machining determines the Stepup value. The more
vertical the surface the lower the Stepup value.
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25. ClickOK. (All other pages retain the default settings.) The toolpath appears on your part.

26. Save your file. In the next exercise you will verify the toolpath.

Exercise 2: Verifying the Toolpath
In this exercise, you will use Mastercam Simulator to view and verify the Dynamic OptiRough toolpath.

1. Your file, Heart mm-XXX.mcam, which you saved from the previous exercise should be open
inMastercam.
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2. In the ToolpathsManager, click Verify.

The part opens inMastercam Simulator.

3. Select the Visibility checkboxes on the ribbon to experiment with what shows in the graphics
window.
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4. Use the playback bar at the bottomof Mastercam Simulator to run the simulation. The simulation
shows that the toolpath hasmany very shallow passes and the total time for the OptiRough
toolpath is lengthy.

NOTE
Your Toolpath Info time may vary.

5. Close theMastercam Simulator dialog box and return to Mastercam tomake adjustments to
the OptiRough toolpath.

6. In ToolpathsManager, click Parameters for the Dynamic OptiRough toolpath.
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7. Click the Cut Parameters page in the tree control.

8. Enter a larger Stepdown value which determines the spacing between adjacent passes.

9. Enter a larger Stepup value as shown in the following image.

10. ClickOK.

11. In the ToolpathsManager you will notice that the Dynamic OptiRough toolpath ismarked dirty,
indicating that it must be regenerated.

12. Click Regenerate all dirty toolpaths on the ToolpathsManager toolbar.
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The regenerated toolpath shows in the graphics window. Note that the number of toolpath
passes has been significantly reduced.

13. Click Verify to return to Mastercam Simulator.
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14. Run the simulation again and see that the total time has been reduced but the results are still
acceptable.

15. Save your file.
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SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. A finishing toolpath always follows a roughing toolpath.

a. True

b. False

2. Verify only simulates toolpathmotion.

a. True

b. False

3. Once they are created, toolpaths can not be modified.

l True

l False

4. When you create a roughing toolpath, youmust enter a stock to leave amount.

a. True

b. False

5. The cutting tool for a roughing toolpathmust be same size or less than the smallest, inside radius
of the surface you are cutting.

a. True

b. False

6. The primary purpose of a roughing toolpath is to remove large areas of unwantedmaterial.

a. True

b. False

7. Roughing toolpaths can reduce the amount of time it takes to completely machine a part.

a. True

b. False
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CHAPTER 4
FINISH MOLD PROGRAMMING

Finish toolpaths remove a small amount of material and produce the final surface quality of the part.
Typically a finish toolpath follows a roughing toolpath, but that is not required.

When a finish toolpath is used in conjunction with a roughing toolpath, the finish toolpath removes the
material designated as stock to leave on walls or floors of the part. Programming a part using rough
and finish toolpaths usually produces a part in the least amount of time.

Goals

l Programa finish toolpath

l Understand the concepts of machining and avoidance geometry

l Understand and apply a containment boundary to a toolpath

l Explore tool libraries including filtering by tool type

l Experiment with toolpath verification usingMastercam Simulator

Exercise 1: Creating the Scallop Toolpath
In this exercise, you will programa finish toolpath on top of the OptiRough toolpath to create a smooth
finish on the mold surface.

1. Your file, Heart mm-XXX.mcam, which you saved from the previous chapter should be open
inMastercam.

2. Right-click and choose Fit and set your view to Isometric (WCS).

3. In the LevelsManager, make the heart and the wireframe containment boundary levels visible.

4. In ToolpathsManager, verify that the red insert arrow is below the OptiRough toolpath. Use the
Move insert arrow controls to move the arrowup and down in the ToolpathsManager.
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5. Select the Dynamic OptiRough toolpath. A green check on the folder indicates that it is selected.

6. Click Toggle display on selected operations as shown in the previous image. The toolpath is
hidden in the graphics window.
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7. On theMill Toolpaths tab, click Scallop in the 3D group.

NOTE
Click the expander button in the 3D group to view the entire toolpath gallery.

TheModel Geometry page of the Scallop dialog box displays.

8. Click Select entities in theMachining Geometry section.

9. Use window select to select the heart and slot geometry.
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10. Rotate the part andmake sure that all parts of the mold to be machine are selected.

11. Click End Selection to return to theModel Geometry page.

12. The finish toolpath will remove the stock to leave amounts that were entered for the OptiRough
toolpath. Click Reset stock values to returnWall Stock and Floor Stock to 0.0.

13. Click the Toolpath Control page in the tree control.
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In this page you will choose the containment boundary to limit the area that will be machined.

14. Click the Boundary chains select arrow.

TheWireframe Chaining dialog box displays.

15. Select the containment boundary wireframe.

16. ClickOK to close theWireframe Chaining dialog box and return to the Toolpath Control page.
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17.  Select Center to Compensate to.

18. Click the Tool page in the tree control.

19. Click Select library tool.

20. Deselect the Filter Active checkbox and then click Filter.

The Tool List Filter dialog box displays.
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21. Clear the filters by clickingNone.

22. Choose the Endmill2 Sphere filter and then clickOK.

23. Select the BALL-NOSE END MILL - 3 from the library of tools and clickOK.

24. Enter the following values for the tool.

CAUTION
These valuesmay vary depending on your machine andmaterial.
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25. Click the Cut Parameters page in the tree control.

26. Deselect Expand inside to out to have the toolpath cut from the perimeter of the heart toward
the center.

27. ClickOK. (All other pages retain the default settings.) The toolpath appears on your part.
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28. In the ToolpathsManager, click Verify and openMastercam Simulator.
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29. Use the playback bar to run the simulation.

30. Save your file.
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SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. When finishing, youmust use a cutting tool the same radius or smaller than the smallest, inside
radius of the surface you are cutting to clean-up any unmachined areas.

a. True

b. False

2. You can use the same tool to both rough and finish cut.

a. True

b. False

3. Your stepover should be less than 10% of your cutter’s diameter to get the best surface finish, .

a. True

b. False

4. You can always achieve a perfectly smooth finish with one finish toolpath.

a. True

b. False

5. Typically, the cutter you would use to get the smoothest surface on a finish toolpath would be:

a. Flat endmill

b. Drill Bit

c. Ball endmill

d. Spherical endmill

e. Both C and D

6. The Finish Scallop toolpath does not have a stock to leave option .

a. True

b. False

7. When you set the cut parameters of a Finish Scallop toolpath, you can control whether the
cuttingmotion starts from the center andmoves in or the perimeter andmoves out.

a. True

b. False

8. List some benefits of using Verify to review your toolpaths?
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CHAPTER 5
SLOT PROGRAMMING

The slot is a long narrow shape that will be programmed using a rough and finish Scallop toolpath.
Using the ToolpathsManager Copy function, you will quickly create the finish toolpath based on the
rough toolpath withminimal edits required.

Goals

l Programa rough Scallop toolpath

l Use Copy to quickly create a finish Scallop toolpath

l Create a containment boundary usingWireframe tools

l Explore tool libraries including filtering by tool type

l Experiment with toolpath verification usingMastercam Simulator

Exercise 1: Creating the Rough Scallop Toolpath
In this exercise, you will create a containment boundary for the slot area of the mold and then
programa rough Scallop toolpath.

1. Your file, Heart mm-XXX.mcam, which you saved from the previous chapter should be open
inMastercam.

2. Right-click and choose Fit and set your view to Isometric (WCS).

3. In the LevelsManager, make the heart and the containment boundary levels visible.

4. Select both toolpaths and then click Toggle the display of selected operations or press
[Alt+T] to hide the toolpaths in the graphics window.
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5. Adding a new toolpath group will help you organize the file. Right-clickMachine Group-1 and
select Group, New Toolpath group.

6. In ToolpathsManager enter Slot Toolpaths for the name of the newgroup. Press [Enter] to
accept.
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7. Right-click Toolpath Group-1 and select Groups, Rename.

8. Enter Heart Toolpaths for the newname.

9. Ensure that the red insert arrow is below the Slot Toolpaths group.

In the next steps you are going to create a containment boundary to keep the machining inside
the slot.

10. On the LevelsManager, make level 3 Slot geometry the active level and turn on the visibility.
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11. In PlanesManager, make the Top plane active and then click Set your current WCS,
construction plane, and tool plane with their origins to the selected plane.

12. Right-click in the graphics window and set your view to Top (WCS).

13. On the View tab, clickWindow.

14. Window select the slot area to magnify that region.

15. OnWireframe tab, click Rectangle.
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16. Draw a rectangle around the slot geometry as shown in the following image.

The rectangle can be placed any where on the Z plane. It will be used as a containment boundary
whenmachining from the top.

17. On theMill Toolpaths tab, click Scallop in the 3D group.

18. On theModel Geometry page, click Select entities in theMachining Geometry section.
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19. Select the slot surfaces and any surfaces tangent to the slot.

20. Click End Selection to return to theModel Geometry page.

21. For a rough toolpath you will designate a certain amount of stock to leave on the part. This stock
will be removed with the finish toolpath. Double click theWall Stock and Floor Stock fields of
Machining Geometry to activate themand enter 1.0.

22. Click the Toolpath Control page in the tree control.

In this page you will choose the containment boundary to limit the area that will be machined.
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23. Click the Boundary chains select arrow.

TheWireframe Chaining dialog box displays.

Hold down the [Shift] key and select a segment of the containment boundary wireframe.
[Shift+click] selects all tangent segments.

24. ClickOK to close theWireframe Chaining dialog box and return to the Toolpath Control page.
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25. Select Inside to Compensate to. This forces the tool to machine inside the containment
boundary.

26. Click the Tool page in the tree control.

27. Select the BALL-NOSE ENDMILL - 3 as the tool and enter the values shown in the following
image.
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CAUTION
These valuesmay vary depending on your machine andmaterial.

28. ClickOK. (All other pages retain the default settings.) The toolpath appears on your part.

29. In the ToolpathsManager, select Toolpath 3 and click Verify. Only the selected toolpaths will be
verified inMastercam Simulator.

30. Use the playback tools to view the simulation and then close Mastercam Simulator.
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31. Save the file.

Exercise 2: Creating the Finish Scallop Toolpath for the Slot
In this exercise, you will copy the rough Scallop toolpath andmake modifications so it can be used as a
finish toolpath.

1. Your file, Heart mm-XXX.mcam, which you saved from the previous exercise should be open
inMastercam.

2. In ToolpathsManager, right-click Toolpath 3 and choose Copy.
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3. Ensure that the red insert arrow is below Toolpath 3 and then right-click and choose Paste.

Toolpath 4, which is a duplicate of Toolpath 3 appears in the ToolpathsManager.

4. Click Parameters for Toolpath 4.
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5. Open theModel Geometry page.

6. The finish toolpath will remove the stock to leave amounts that were entered for the rough
Scallop toolpath. Click Reset stock values to returnWall Stock and Floor Stock to 0.0.

7. ClickOK. (All other pages retain the default settings.)

8. In the ToolpathsManager, Toolpath 4 is marked dirty, indicating that it must be regenerated.

9. Click Regenerate all dirty toolpaths on the ToolpathsManager toolbar.
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10. In the ToolpathsManager, click Select all operations. Each toolpath will have a green check
indicating it is selected.
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11. Click Verify to openMastercam Simulator.

12. Play the simulation through then use the Visibility controls on the ribbon to change what you
see. Experiment with the playback controls at the bottomof the screen tomove forward and
backward through the simulation.

NOTE
Click the help icon in the upper corner of Mastercam Simulator to learnmore about
the program.

13. Close Mastercam Simulator when you are done.

14. Save the file. You are now ready to send your file to the post processor and create the NC
program.
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SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. You can use filters to narrow the type and number of tools you see in the tool library.

a. True

b. False

2. What is the best way to reuse a toolpath?

a. Copying and pasting it in the ToolpathsManager

b. Exporting the parameters into an Excel file and reimporting the operation with a
different name into your part file.

3. Youmust select toolpath geometry one entity at a time.

a. True

b. False

4. You can select machining surfaces and set stock to leave values on the Model Geometry page of
a toolpath dialog box.

a. True

b. False

5. Which of the following is not a compensation option for Containment Boundary?

a. Inside

b. Above

c. Center

d. Outside

6. The only way to tell how long an operation will take to complete is to run it on the machine.

a. True

b. False

7.  Describe how you could get a better view of an issue with a deep cut that you notice when you
are using Verify. Make sure youmention the controls you would use.
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CHAPTER 6
POST PROCESSING

Post processing, or posting, refers to the process by which the toolpaths in your part file are
converted to a format that can be understood by your machine tool's control (for example, G-codes). A
program called a post processor, or post, reads your part file and writes the appropriate NC code.
Generally, every machine tool or control requires its own post processor, customized to produce code
formatted to meet its exact requirements.

In this chapter you will explore post processing using the default mill machine chosen for this project.
If you use a different machine, it will require a different post.

Goals

l Understand post processing concepts

l Explore Code Expert and the NC code

Exercise 1: Post Processing the Operations
In this exercise, you will send the completed file to post processor. The post processor creates a
machine-readable NC program from the Mastercam file.

1. Your file, Heart mm-XXX.mcam, which you saved from the previous chapter should be open
inMastercam.

2. Verify that all of the toolpaths are selected in ToolpathsManager.
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3. ClickG1 to post the toolpaths for the selected operations. The post processor creates amachine-
readable NC program from the Mastercam file.
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The Post processing dialog box displays. The name of the post processor for the machine you
have chosen displays as the Active post field in read-only mode.

4. ClickOK. The Save As dialog box opens.

5. Name your NC file and click Save.
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The file opens inMastercamCode Expert.

6. Use the Code Expert controls to explore the NC code.

NOTE
Click the help icon in the upper corner of MastercamCode Expert to learnmore
about the program
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SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. The post processor creates amachine-readable NC program from the Mastercam file.

a. True

b. False

2. Youmust post all of the operations in the ToolpathsManager.

a. True

b. False

3. Posted NC programs consist mainly of X, Y and Z values that represent point locations in on the
CNCmachine.

a. True

b. False

4. Describe how you transfer the information in your Mastercam file to your machine?
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CHAPTER 7
CHALLENGE: SELF-GUIDED PROJECT

Now that you have a basic understanding of designing and programming amold inMastercam, it’s time
tomake one of your own. For this self-guided project, you will be creating amold inMastercamwith a
maximum size of 100 mmx 100 mmx 25.4 mm. The model you use for your moldmay be obtained
fromanumber of online resources including GrabCAD (www.grabcad.com) and the SOLIDWORKS CAD
model library (https://my.solidworks.com/cadmodels/explore) or created on your own using the
powerful CAD features found inMastercam.

Successful completion of this self-guided project will demonstrate the following skills in Mastercam:

l How to use Mastercam's wireframe and solidmodel design tools to create amachinable, solid
model.

l Programming a part with roughing and finishing toolpaths.

l Securing stock to the machine.

l Confirming toolpath operations withMastercam Simulator (Verify).

As part of this project, you will be expected to prepare a brief presentation. The presentation should
be no longer than 5 minutes and clearly outline the steps that you have taken to complete the project,
including which ideas you explored, what new technology you learned to facilitate the process,
projects that you experienced and how you overcame them, and how you improved the project from
inception through to the finished product.

This self-guided project will be evaluated against the following categories:

l Creativity – the process and ability to explore and expressmultiple ideas in a unique way.

l Initiative – the ability to overcome projects independently and with a positive attitude.

l Iteration – the ability to develop the product with progressive improvement over time.

l Continued Learning – the ability to attempt new techniques as part of the project.

l Presentation – the ability to articulate and explain the process and project.

MOLD MODEL TIPS
l Use draft when possible to make removing your part easier. A goodmold would be shaped like
an upside-down pyramid, where the widest part is at the top and the narrowest at the bottom. A
good example of amold is an ice cube try, where there is a taper from the top down and inward
to the bottom.

l Add an angled or tapered edge to the top to help release the mold part from the mold body if
the walls of the mold are very steep.
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l Put a stick in it! A stick in the mold can be useful in pulling the part cleanly out of the mold.
Remember, you will have to create and cut a channel add this stick to your mold, and you'll need
to consider how to keep the part material leaking out.

l Avoid models with undercuts. An undercut is when the top of the model is narrower than the
bottom.
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l Avoid textured surfaces. The smoother the surface, the easier it will be to remove the part
from the mold. Textured surfaces will grip your material. It is likely that your part will not release
cleanly from the mold and could be damaged in the process.

l Avoid sharp corners and knife-edges. Use fillets and chamfers to soften these when they can't
be avoided.

Quick Part Series - Chocolate Mold—7: Challenge: Self-Guided Project



l Be flexible! Rigidmaterial canmake it difficult to remove a part from your mold, even in the best
of circumstances. Consider using a flexible mold body like silicone or even amultiple piece mold
so that the part can be removed without damage.

l Use a release agent. A moldmay be the perfect shape to release and they part could still not
come out easily or at all. Consider coating your mold with a release agent, such as petroleum
jelly, baby powder, nonstick spray or anything else the will help keep the mold and part from
holding on to each other. Keep inmind, any possible physical or chemical affects your release
agent will have on the finished part!

l Consider shrinkage. Shrinkage is ameasurement based on change and is represented as either
a ratio or as a percentage. Most materials will expand when heated and will shrink when cooled.
This can cause the part to either pull away from the mold andmake it easier to release, or cause
the mold to tighten around the part andmake it harder to release. It is not uncommonwhen
making a candy with amold, to chill the mold after the part material is added to help the candy
shrink and release from the mold.

If the finished part must be a specific size, youmay need to be scale the mold for shrinkage so
that the part is the correct size. Use the following equation to determine the difference between
the mold and part dimension is:

Ratio = (mold – part) /mold

% = (mold – part) (100%) / mold
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CONCLUSION
Congratulations! You have completed the Quick Part Series - Chocolate Mold! Now that you have
mastered the skills in this tutorial, explore Mastercam's other features and functions.

Youmay be interested in other tutorials that we offer. Mastercam tutorials are being constantly
developed, and we will addmore as we complete them. Visit our website, or select Help, Tutorials
from the File tab.
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